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FlowLogic 7.2.1 - Introduction 
 
Layout Overview – GateLogic, GraphLogic and DocLogic 
 
FlowLogic is divided into three sections: GateLogic, GraphLogic and DocLogic. 
These sections are accessed by clicking on the tabs located at the top of the 
program window. 
 
GateLogic is where FCS files are imported, gates are drawn on plots, overlays 
are created, data array analysis is performed and gate statistics are set and 
viewed. 
 
GraphLogic is where statistical analysis is performed and graphs are created 
for both FCS-derived and independent data. 
 
DocLogic is where reports and presentations are created by adding elements 
created in GateLogic and GraphLogic. Plots, plates and statistic tables, 
amongst other items, can be added to reports to be displayed as a presentation, 
saved as a PDF or printed. Documents can also be annotated with a range of 
shapes, images and text. 
 
All three sections are linked, so when a gate is modified in GateLogic, statistics 
and reports in GraphLogic and DocLogic, are updated automatically. 
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FlowLogic Technical Specifications 
 

• Cross-platform software that runs in Windows, Mac and Linux operating 
systems 

• Operates in both 32- and 64-bit environments 
o Maximum memory allocation in 32-bit environments is 1026Mb 

• Analysis files saved under one operating system can be opened under 
another 

• Requires Java SE Development Kit (JDK) 8 and above 
o The JDK is a free download from the Oracle website 
o JDK 8 is recommended for 32-bit environments  
o JDK 9 is recommended for 64-bit environments 
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Preferences 
 
Before beginning an analysis, customize the program by setting the program 
preferences. From the menu bar, select ‘FlowLogic’ (Mac) or ‘Edit’ (Windows) 
and ‘Preferences’. Here you can change the way the plots are displayed 
(annotation, standard or high definition, real-time updates, etc.), choose the 
specific parameter labels you would like to view, set the export settings, allocate 
system memory, define colors used in overlay plots and more. 
 

 
 
Select various Preference menu options from the left-hand side of the 
Preferences window and optimize the settings using the options in the window 
on the right. 
 
Explanations of the different Preference options are as follow: 
 
 
General  
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• Plot Options 
 

• Real-time plot updates – when selected, all plots (dot plots, histograms 
and overlays) are updated in real-time as gates are moved. This includes 
events at all levels of the population hierarchy, along with gate statistics. 
The coloring of events (selected in the plot side drawer in the Gate List 
tab) is also updated on all levels of the hierarchy as gates are moved. 
Deselect this option to increase program speed. When deselected, all 
plot and statistic updates will occur when the gate is released. 

 
• High definition dot plots – when selected, dot plots are displayed in the 

Workspace at a higher definition. Plots will also be exported and 
displayed in reports with whichever setting is chosen. 

 
• Show events on histogram axis – when selected, events existing beyond 

the axes will be displayed along the axes. This may affect the way the 
histogram is displayed, especially when viewing the histogram at 100%. 

 
• Show events on dot plot axis – when selected, events existing beyond 

the defined axes will be displayed along the axes. This will affect the plot 
display, especially when viewing populations based on density. 
Deselecting this option will cause the density of events to be calculated 
based on the events within the plot area only. This option does not 
impact statistics in any way. 

 
• Open density plot as default – when selected as the default settings, all 

plots opened from the File Inspector or from double clicking within a gate 
in the Workspace will open as a density plot. This default setting will 
remain for a sample once it has been opened so changing the default 
setting in the Preferences will apply to all newly opened plots. 

 
• Save opened plots in window – when selected, plots displayed in the 

Workspace for a given folder will be remembered so that the same plots 
will be displayed when switching from one folder to another and back 
again. This is the case for all Experiment folders in all Projects (displayed 
in the File Navigator). Plots displayed in the Workspace when quitting 
FlowLogic will be displayed upon opening a saved .GLF or 
.GatelogicExperiment file. 

 
• Default histogram smoothing – histograms can be smoothed by default. 

This can be particularly useful in cases where there are few events. 
Choose either None or one of the other smoothing options to apply the 
relevant algorithm to the histogram: None, Traditional, Local Max, Local 
Min, Local Mean, Box Max, Box Min, Box Mean. 

 
• Default smoothing size – the amount of smoothing can also be set, 

ranging from 2 (least amount of smoothing) to 16 (most amount of 
smoothing). 
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• General Options 
 

• Warn before closing FlowLogic – when selected, FlowLogic will display 
the following message asking whether to cancel the command, to quit or 
to save the current analysis before quitting: 

 

 
 

 
• Automatically release license before closing FlowLogic – when selected, 

FlowLogic will release the license automatically upon quitting. The 
license is then free to be used to run FlowLogic on a different computer. 
This feature is useful if the user commonly runs FlowLogic on two or 
more computers. 

  
• Fast FCS File Dialog – with this feature enabled, when searching for files 

to import, FlowLogic will inspect the file header to quickly identify FCS 
files. This will dramatically increase the speed in which FCS files can be 
searched and displayed. 

 
• Limit Available Fonts – limiting available fonts will reduce the available 

fonts contained in each computer to the following: 
 

 
 

This will ensure that saved analyses and reports, when opening on other 
computers, will be displayed unchanged. Limiting the available fonts 
avoids the risk that a font used in one computer is absent in another. 
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• Autosave Options 
 

• Enable Autosave Every __ Minutes – with this option, FlowLogic will 
automatically prompt the user to save the analysis after a defined 
number of minutes. Once the analysis has been saved, FlowLogic will 
re-save the analysis, using the same file name and type, at the defined 
time interval. The time interval can be set by typing the number of 
minutes in the field or by using the arrows to increase or decrease the 
displayed time in one-minute increments. 

 
• Enable Undo – with this setting selected, a list of the most recent actions 

is recorded and can be reversed by selecting Undo from the Edit menu 
or by selecting the action from the Undo List found in the Edit menu. 

 
• Statistics Setting  
 

• Stat with negative – this setting means that some statistical calculations 
on data existing below zero may come back with an error due to the 
nature of the calculation. 

 
• Stat without negative – this setting means that all statistics can be 

calculated even if there is data existing below zero. This is achieved by 
ignoring the events that exist with a negative value. 

 
 

• Import Setting (Duplicate Files) 
 

• Allow all files – with this setting, all files can be imported, even if there 
are two identical files. 

 
• Prevent duplicate names – with this setting, the importation of two files 

with the same file name will be prevented. This setting becomes 
important if the same experiment is repeated and therefore the same 
names are applied to the samples, although acquired at different times. 
Plate data will also produce multiple samples with the same name as the 
well name is commonly the sample name, i.e. A1, A2, etc. 

  
• Prevent duplicate files – with this setting, the importation of two identical 

files will be prevented. 
 
• Gate Options 
 

• Auto open daughter plots – with this option selected, the daughter 
population resulting from a gate is displayed in the Workspace when a 
gate is created. 

 
• Back gating on by default – with this option selected, populations are 

colored as a gate is created. As subsequent plots are created, the 
colored populations appear on all plots in the hierarchy. 
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• Show gate label – the gate label is the gate name and the statistic 
relating to a gate. This will be displayed on the dot plot or histogram 
when this option is selected. The gate label can be moved around the 
plot area when the gate is highlighted. 

 
• Hide gate label text – choosing to hide the gate label text will remove the 

gate name from the label, leaving only the associated gate statistic. 
 
• Gate Label Value – the type of statistic displayed as part of the gate label 

can be chosen from the following options: 
• Event Count 
• Percentage Parent 
• Percentage Total 
• No Stat Display – choose ‘No Stat Display’ in combination with 

showing the gate label text to display the gate name alone. 
 

• Gate Naming – the ‘Gate Naming’ option means that a box (as displayed 
below) will be displayed each time a gate is created, asking for a name 
to be assigned. The default name will be presented within the window 
each time a gate is created. If this option is not selected, then the default 
gate name is automatically assigned to the gate. The gate name can 
always be changed by right clicking on the gate name in the File 
Inspector, choosing Rename and typing in the new name. 

 
 

 

 
 
 
• Sorting Settings 
 

• The Sorting Settings refer to the default order in which FCS files are 
displayed in the File Inspector. This option includes sorting by File Date 
(the date the file was created), File Name (alphabetically ordered), FCS 
Date (the date and time of acquisition), Free, Plate Position, or $SRC 
keyword. 
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Parameters  
 

 

 
 

 
• Axis Adjustments 

• Plot from zero – choose to plot from zero or to hide the first decade of 
events. 

• LogScaled Transformation –LogScaled axes will be displayed by default.  
• Auto Axis Adjustment – FlowLogic will determine the optimal scaling for 

the axes. 
• Import FCS Files Compensated – when selected, imported FCS files will 

load with the compensation matrix created at the time of acquisition. If 
not selected, the imported files will be uncompensated. 
 

• Parameter Labels 
• Parameters Labels – selecting Parameter Labels displays the parameter 

name on the plot axis. 
 
• User Labels – selecting User Labels displays the parameter and the 

parameter name as defined at acquisition. 
 
• Custom Labels – selecting custom labels displays a new label that can 

be created in the Advanced Functions pull up drawer in the Parameters 
tab. Here, all three parameter label types are displayed but only the 
custom labels can be changed. Double clicking on the existing Custom 
Label allows the creation of a new custom label. 
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• Log Axis – set the default axis labeling style 
o Auto (displays the native format) 
o 1e1, 1e2, etc… 
o Traditional 

 
• X Axis 

• Major Ticks – increasing the number in this field, either by typing a new 
number or by using the arrows to increase the value, will lengthen the 
major axis markers. Decreasing the value shortens the major axis 
markers. 

 
• Move Horiz. – increasing this value shifts the x-axis marker values, e.g. 

0, 103, 104, to the right. Decreasing this value moves the x-axis markers 
to the left. 

 
• Move Name Horiz. – increasing this value shifts the x-axis title, i.e. the 

parameter name, to the right. Decreasing this value moves the x-axis 
title to the left. 

 
• Minor Ticks – increasing the number in this field, either by typing a new 

number or by using the arrows to increase the value, will lengthen the 
minor axis markers. Decreasing the value shortens the minor axis 
markers. 

 
• Move Vert. – increasing this value shifts the x-axis marker values, e.g. 

0, 103, 104, further from the axis (down). Decreasing this value moves 
the x-axis marker values closer to the axis (up). 

 
• Move Name Vert. – increasing this value shifts the x-axis title, i.e. the 

parameter name, further from the axis (down). Decreasing this value 
moves the x-axis title closer to the axis (up). 

 
• Set Default – click set default after all adjustments have been made. This 

will then save the default settings for future analyses. 
 
 

• Y Axis 
• Major Ticks – increasing the number in this field, either by typing a new 

number or by using the arrows to increase the value, will lengthen the 
major y-axis markers. Decreasing the value shortens the major axis 
markers. 

 
• Move Horiz. – increasing this value shifts the y-axis marker values, e.g. 

0, 103, 104, to the left. Decreasing this value moves the y-axis markers 
to the right. 

 
• Move Name Horiz. – increasing this value shifts the y-axis title, i.e. the 

parameter name, to the left. Decreasing this value moves the y-axis title 
to the right. 
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• Histogram Ticks – increasing the number in this field, will lengthen the 
major y-axis markers on histograms. Decreasing the value shortens the 
major y-axis markers. 

 
• Minor Ticks – increasing the number in this field, either by typing a new 

number or by using the arrows to increase the value, will lengthen the 
minor axis markers. Decreasing the value shortens the minor axis 
markers. 

 
• Move Vert. – increasing this value shifts the y-axis marker values, e.g. 

0, 103, 104, down. Decreasing this value moves the y-axis marker values 
up. 

 
• Move Name Vert. – increasing this value shifts the y-axis title, i.e. the 

parameter name, down. Decreasing this value moves the y-axis title up. 
 
• Set Default – click set default after all adjustments have been made. This 

will then save the default settings for future analyses. 
 
 
Export 
 

 
 
• Plot Export Options – selecting the following options will define the 

elements exported with dot plots and histograms. Some export file types 
can be ungrouped and edited at a later point. For file types that can’t be 
ungrouped, define the elements that you wish to be displayed on each plot 
here prior to exporting. 
• Axis – this incorporates the major and minor ticks, the axis marker values 

e.g. 0, 103, 104 and axis titles 
• Axis Values – this is the axis marker values, e.g. 0, 103, 104 
• Axis Labels – this is the axis title, e.g. parameter name 
• Statistics – statistics relating to the parameters will be exported with the 

plot. 
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• Header – this is the sample name and associated statistics. These sit at 
the top left-hand corner of the exported plot. 

• High Quality Graphs (72, 150, 300, 600, 1200 DPI) – the resolution of 
the exported image can be set in terms of dots per square inch. 

• Export Group Color when plate displays plots – dataset colors will be 
exported with the plate if set to display plots and color background with 
dataset. 

 
 
Palette 
 

 
 
  



 14 

• Density plot colors 
 

 
 

• Set Palette – to load a density plot color scheme, select it from the drop-
down menu at the bottom of the Palette preferences window. Click Set 
Palette to confirm selection. 

• Save As – new palettes can also be created. To create a palette, highlight 
the selected region of the density plot colors. A color chart window will then 
ask to choose a start color followed by an end color. The color transition will 
then be spread over the defined region. To save a new palette, click Save 
As. The program will then save a new Gatelogic Palette File. 

• Load – to load a previously saved palette, click load and locate the saved 
Gatelogic Palette File. 

 
 
User Interface 
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• Set the user interface layout 
• Single Window View – this layout combines all of the elements of 

FlowLogic into a single window, which is itself divided up into sections 
that can be resized to best suit the user. 

 

 
 
 
• Multiple Window View – this layout creates a new window for each 

element, such as each dot plot, histogram or data array. The windows 
are detached from the main program window and can be moved 
anywhere on the screen, including on top of other windows. In this 
layout, the Workspace toolbar is located at the top of each of the opened 
plots. If the plot is too small to display the entire toolbar, the gating 
options and the plot display options are stacked and clicking on one will 
reveal the remainder in drop down menu. 
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• Split Screen View – this layout separates the Workspace from the rest 
of the program. In this way, the Workspace can be expanded to fill an 
entire screen. This could be particularly useful if two screens are 
available. 

 

 
 

 

System 
 

 
 

 
• Set Memory in MB. Check your computer’s maximum RAM 

specification and enter it below – maximizing the RAM dedicated to 
FlowLogic will improve program speed and performance. 
• Type in the available RAM available for FlowLogic in MB. 
• For example, if your computer has 4GB of RAM, enter “4000” (i.e. the 

amount of RAM in MB) 
 

• For computers running 32-bit Java, 1024 MB is the maximum amount of 
memory that can be allocated. 
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• File Associations – for machines running Windows, double clicking on the 
following file types will launch the program and load the files. 
• .GLF Files 
• .FCS Files 
• .GateLogicExperiment Files 
• .LMD Files 
• Set File Associations 
 

• LMD file reading preferences – the portion of the LMD file, FCS2.0 or 
FSC3.0, can be set as the default portion to read. This setting applies to all 
future LMD file imports. It will not change the reading of files that have 
already been imported. 

 
DocLogic 
 

 
 
Default setting for reports can be set in the program preferences. 
 
• Default Paper Type 

• Set – click set to choose the default paper size for each new report. A 
page setup window will appear. 

 
• Preview On By Default – the page preview is displayed down the right 

hand side of the screen in DocLogic. It provides an overview of the whole 
document and can be used to navigate from one page to another by clicking 
on the desired page. If the preview is set to be on by default, it will be present 
each new time DocLogic is opened when starting FlowLogic. 

 
• Default Layout  

• Grid – items added to a report will be placed in specific positions defined 
by the size of the grid. 

• Free – items added to the report can be moved around freely. 
• Default Grid Width (1-10) 
• Default Grid Height (1-10) 
• Default Snap Size (1, 2, 4, 8, 16, 32, 64, 128) 
• Default Background 
• Hide Doc Toolbar 
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PlateLogic  
 

 
 

• Non-Parametric Statistic Selected 
• Display Selected Level 
• Display Parent 
• Display File 

• Parametric Statistic Selected 
• Display Selected Level 
• Display Parent 
• Display File 

• Fill enabled by Default  
• View histo enabled by Default 
• Default Size – this is in terms of the number of wells in the horizontal 

direction (rows) and the number of wells in the vertical directions 
(columns). Change either of the numbers by clicking within the field and 
typing the new number or by using the up and down arrows to increase 
or decrease the number of wells running horizontally or vertically. 

• Default Fill Direction – the fill direction relates to the placement of 
progressive samples added to a plate. 
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• Default Well Shape – the default well shape can be set as a circle, 
square, large square or to have the entire area filled. Click on the drop-
down menu to make the selection. 

 

 
 

• Default Numeric Axis – axes (rows and columns) can be listed either 
alphabetically or numerically. To label an axis numerically, tick the box 
next to the relevant axis. If the box is not selected, the axis will be labeled 
alphabetically. It is possible to list one axis numerically (and the other 
alphabetically), both axes numerically or both alphabetically. 

• Default Statistic – choose the statistic that you wish to be displayed by 
default. 

• Mirror dataset on Insert by Default – this feature, when enabled, creates 
datasets in the plate that match the groups from the File Inspector. The 
group color is applied to the matching dataset. 

• Insert Files in Plate Order – files will be added to a plate in the order of 
A1, A2, A3, etc. 

• Autoheatmap Enabled by Default – heatmaps can be generated 
automatically when samples are dragged from the File Inspector into a 
plate in the Data Array tab located in the Advanced Functions pull up 
drawer. If the ‘Autoheatmap Enabled by Default’ option is selected, then 
FlowLogic will perform a calculation based on the range for the selected 
statistic. The wells in the plate will then be colored from, blue to red, over 
the ranges outlined in the Default Heatmap settings in the Preferences 
window. 

 
• There are five ranges for the heatmap by default. However, extra ranges 

can be added, or existing ranges can be removed by selecting a range, 
rick clicking and choosing from the options provided. These are as 
shown below: 

 

 
 

If ‘Copy’ is selected, a copy of the selected range will be automatically 
created and placed after the copied range. 

 
• C (color) – the default color assigned for each range for the heatmap can 

be changed by clicking on the color itself and choosing from the options 
provided. 
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• A (bottom of range) – the default value defining the bottom end of the 
range can be changed by double clicking within the filed in the column 
labeled ‘A’. 

 
• Type – this is the rule defining each range in the heatmap, in relation to 

the values in columns ‘A’ and ‘B’. The type options are: 
• Less than A 
• Less than or Equal to A 
• Greater than or Equal to A 
• Equal to A 
• Greater than or Equal to A and Less than B 
• Not Greater than or Equal to A and Less than B 
 

• B (top of range) – the default value defining the bottom end of the range 
can be changed by double clicking within the filed in the column labeled 
‘B’. 

 
• The default heatmap colors can also be defined in this panel. This can 

be done by clicking on individual colors and making a selectin from the 
resulting color selection window or by applying a gradient between two 
colors. Do define a gradient, highlight all ranges, right click and choose 
‘Gradient’. Then select the starting color followed by the ending color. 
The intermediate colors will be set automatically. 
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Overlay 
 

 

 
 

 
• Set overlay color – the default colors for the first 13 samples to be added 

to dot plot or histogram overlays are displayed here in the Preferences. The 
default color for each of these 13 samples can be set here by clicking on 
the color and then choosing a new one from the options provided. Overlay 
colors can be changed on individual overlays once it has been created. 

 
• Set transparency 

• Low (0-255) High – the default level of transparency can be set. This 
refers to the degree as to which a sample located behind another can 
be seen. 

• Sort the list of plots – when selected, samples will be added to an overlay 
with the highest density/histogram height at the back and lowest 
density/histogram height at the front. If ‘Sort the list of plots’ is not the 
default setting, then samples will be added in order the files are 
displayed in the File Inspector. These settings can be changed within 
the side drawer of each overlay plot by right clicking within the Overlay 
Colors tab. 
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• Calculate statistics – statistics for all samples in the overlay can be 
displayed in the statistics tab in the overlay side drawer. The default 
selection of statistics to be displayed can be set in the Preferences 
window. The selection of statistics can be edited for each individual 
overlay within the Stat Settings tab in the overlay side drawer. 

• Display 100% - for histogram overlays, the samples can be set to be 
displayed as either the event count or as a proportion of the highest 
value, which itself is at 100%. This selection determines the default 
display setting for all new histogram overlays. The setting can be 
changed on individual histogram overlays by right clicking within the plot 
area and selecting Display 100%. 

 
• Set Stat Column – default columns can be created in the side drawer of 

overlays, in the Statistics tab. Additional information may be required to 
define the statistic to populate these columns, which can be done in the ‘List 
of linked rows’, ‘Stat settings’ and ‘List of parameters’ tabs of the overlay 
side drawer. The different statistic columns are: 

o Color 
o Population 
o Parameter 
o Events 
o % of Total  
o % of Parent 
o Mean 
o GeoMean 
o Median 
o StdDev 
o CoefVar 
o RoCoefVar 
o % of Selected 
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Main Menu 
The Main Menu contains several key program features and functions. In 
macOS, the Main Menu is set out as follows: 
 

 
 
FlowLogic 
 
About FlowLogic – clicking About FlowLogic opens a window showing the 
program version, the user’s system information (including the RAM and the 
number of cores available to FlowLogic), the license holder’s username, the 
license type and the license expiration date. 

Preferences… – clicking Preferences or using the keyboard shortcut at any 
time will open the program preferences. Here there are options to set default 
options relating to: General settings, Parameter settings, Export settings, 
Palette settings for density plot displays, User Interface settings, Report 
settings, Data Array settings and Overlay settings. 

Quit FlowLogic – select quit FlowLogic or use the keyboard shortcut to exit the 
program. If the ‘Warn before closing FlowLogic’ option has been selected in the 
General program setting in Preferences, then a window will be displayed asking 
whether to save the current analysis before quitting or whether to cancel the 
command to quit. 

 
File 
 
• New – selecting ‘New’ will open a new, blank analysis. Before the new 

analysis is created, a prompt (shown below) will ask whether to save the 
current analysis. 

 

 
 

• Open – selecting ‘Open’ allows for the opening or loading of previously 
saved .GLF and. .GatelogicExperiment files. Before displaying a window 
allowing the search for the saved analysis file, a prompt will ask whether to 
save the current analysis before opening a saved one. 
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• Save – selecting Save or using the keyboard shortcut will save the current 
analysis. If the analysis has not been saved previously, a Save As window 
will open, asking to name the analysis and to choose a file type (either a 
.GLF or a. GatelogicExperiment file). If the analysis has been saved 
previously, then choosing ‘Save’ will update the saved file, incorporating all 
recent changes. 

• Save As – choosing Save As or using the keyboard shortcut will open a 
window allowing the file name and type to be set. If the current analysis has 
already been saved, then creating a new file name will create a new file. 
The original file will remain as it was when it was last saved. 

• Import FCS-MQD-LMD-LXB… – choosing this file import option or using the 
keyboard shortcut will open a search window allowing the user to locate 
FCS stored on the computer or on an external drive. To import the FCS files, 
highlight them and select ‘Choose’. 

 

 
 
• Import Folders – selecting Import Folders or using the keyboard shortcut 

opens a search window where folders containing FCS files can be imported. 
This function imports all of the files in the folder and places them into a new 
Experiment folder, which takes the name of the imported folder. 

 

 
 
• Recent – selecting Recent opens a window displaying the 11 most recent 

analysis files. Select the file by name to open it. 
 
Edit – contained in the Edit menu are various display features and analysis 
tools, including copying, pasting, saving and deleting. 
 
• Undo – selecting Undo or using the keyboard shortcut will undo the last 

action. Clicking Undo again will continue to undo the most recent actions. 
This feature must be enabled in the Preferences under General settings in 
order to use it. 

• Redo – selecting Redo or using the keyboard shortcut will redo an action 
that has just been undone. 

• Undo List – the Undo List shows a list of the most recent actions. This 
visualization allows for a particular action to be identified and by selecting it 
the analysis will return to state immediately prior to this action being 
performed. 

• Keywords – opens the Keyword Configuration window, allowing specific 
keywords and their values to be selected and displayed in the File Inspector. 
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• Plot Arrangement 
• Number of Windows (1 – 20) – the number of windows refers to the 

number of plots (dot plots, histograms or overlays) that are displayed 
horizontally across the Workspace before a plot is placed on the next 
row. Using this feature can greatly enhance analysis as the user can 
adjust the displaying of plots to fit a given screen size or to group 
samples in rows based on experimental groups. For example, if an 
experiment involves three groups, each with five samples per group, 
then setting up the number of windows to be displayed at 5 results in 
each group being displayed in a single row in the Workspace. This 
makes it much easier to compare differences between groups while 
viewing each individual sample. 

• Auto Arrangement on/off – Auto Arrangement is a feature that enables 
plots to keep their position in the Workspace even when individual plots 
are resized. For example, clicking the bottom right hand corner of a plot 
and dragging it downwards will enlarge the individual plot. If there are 
other plots open in the Workspace, these will move in relation to the plot 
being resized. In this way, an enlarged plot will not obscure any other 
plot. Plots can also be moved around the screen by clicking the plot title 
and dragging it to a new location. This will result in the plot obscuring 
other plots if it is dragged on top of another. However, clicking and 
dragging the plot resizing slider at the top of the File Navigator will 
automatically place the plots back in their original order and make them 
a uniform size. The plot resizing slider can also be used to enlarge or 
shrink all plots in the Workspace together. Turning the Auto 
Arrangement off effectively makes each plot free and will all act 
independently when resizing and re-ordering. 

• Plate Arrangement 
• Number of Windows (1 – 20) – the number of windows refers to the 

number of plates that are displayed horizontally across the PlateLogic 
workspace in the Advanced pull up drawer before a plate is placed on 
the next row. 

• Auto Arrangement on/off – this feature enables plates to keep their 
position in the PlateLogic workspace even when individual plates are 
resized. For example, clicking the bottom right hand corner of a plate 
and dragging it downwards will enlarge the individual plate. If there are 
other plates open in the Data Array Workspace, these will move in 
relation to the plate being resized. In this way, no plates will be obscured 
when one is manually enlarged. Plates can also be moved around the 
screen by clicking the plate title and dragging it to a new location. This 
will result in the plate obscuring others if it is moved on top of another. 
However, clicking and dragging the plate resizing slider at the bottom of 
the Plate List Window in the Advanced Functions drawer will 
automatically return the plates to their original order and make them of 
a uniform size. The plate resizing slider can also be used to enlarge or 
shrink all plates in the PlateLogic workspace together. Turning the Auto 
Arrangement off effectively makes each plate free and each will act 
independently when resizing and reordering. 

• Graph Arrangement – this refers to the arrangement of graphs opened in 
the Statistics section of FlowLogic. 
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• Auto Arrangement on/off – this feature enables graphs to keep their 
position in GraphLogic even when individual graphs are resized. For 
example, clicking the bottom right hand corner of a graph and dragging 
it downwards will enlarge the individual graph. If there are other graphs 
open in the workspace, these will move in relation to the graph being 
resized. In this way, no graphs will be obscured when one is manually 
enlarged. Graphs can also be moved around the screen by clicking the 
graph title and dragging it to a new location. This will result in the graph 
obscuring others if it is moved on top of another. However, clicking and 
dragging the graph resizing slider at the top of the File Navigator will 
automatically return the graphs to their original order and make them a 
uniform size. The graph resizing slider can also be used to enlarge or 
shrink all graphs in the graph workspace together. Turning the Auto 
Arrangement off effectively makes each graph free and each will act 
independently when resizing and reordering. 

• Copy Gates – this feature copies gates in order to paste them to another 
sample in the File Inspector. To copy gates, highlight them, select Edit o 
Copy Gates (or use the keyboard shortcut). The gates are then copied to 
the clipboard ready to be pasted onto new samples. The ‘Copy Gates’ 
feature can also be accessed by right clicking on a sample and selecting 
Copy o Copy Gates. 

• Paste Gates – once gates have been copied from a sample, highlight a new 
sample or samples and select Edit o Paste Gates (or use the keyboard 
shortcut) to paste the gates. The gates will be pasted to the sample and not 
appended or inserted into a selected level of the existing gating hierarchy. 
In effect, the gates will replace existing gates on the destination sample. In 
order to insert gates into a specified level of a gating hierarchy, select the 
level (gate) that you wish to insert the gates onto, right click and choose 
Paste o Insert Gates. The ‘Paste Gates’ feature can also be accessed by 
right clicking on a sample and selecting Paste o Paste Gates. 

• Paste Gates To All – once gates have been copied, selecting any gate in 
the File Inspector and clicking Edit o Paste Gates to All will apply the copied 
gates to all samples. 

• Save Template – save the current template 
• Save As Template – Name and save the template 
• Apply Template – select Edit o Apply Template to apply a previously saved 

gating template to an FCS file. A search window will open allowing the user 
to locate the template. 

• Delete Template – search and delete a template 
• Delete Rows – rows refer to the samples and gates shown in the File 

Inspector. To delete one or more rows, highlight the row(s) in the File 
Inspector and select Edit o Delete Rows. This will delete the selected rows 
and any gates lower in the hierarchy. A window will open prior to the rows 
being deleted to confirm the action and to show the gates that will be 
deleted. 

• Delete All Gates – select any row in the File Inspector and then click Edit o 
Delete All Gates to delete all gates and clones listed in the particular 
Experiment Folder. A window (as shown) will confirm the action to delete all 
gates and clones. 
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• Delete All Statistics – selecting Edit o Delete All Statistics will clear any 

statistics calculated and displayed in the Set Statistics Tab in the Advanced 
Functions drawer and all statistics displayed in the View Statistics Tab in 
the Advanced Functions drawer. 

 
 
Compensation – live compensation can be performed in the side drawers 
of individual plots under the Interactive Compensation Matrix tab. Adjust the 
compensation by double clicking in the compensation value tab and typing in a 
new value, by using the up and down arrows to adjust the compensation in 
small increments or use the slide tool to increase or decrease the compensation 
value: 
 

 
 
Once the compensation has been changed for one sample, there are several 
different options available: 
 
• Copy New – to copy the new compensation (in order to paste it to other 

samples) select the sample in the File Inspector with the newly changed 
compensation and click Compensation o Copy New. This will save the new 
compensation matrix to the clipboard. 

• Copy FCS Original – the compensation matrix that was created at the time 
of acquisition remains with the FCS file even if it is changed post acquisition. 
If you wish to apply the original compensation matrix to a file, copy the 
original FCS and paste it to any sample in the File Inspector. 

• Copy Saved – a sample compensation matrix (either the original matrix or 
an altered one) can be saved as a TXT file and applied to samples in the 
File Inspector. To select a saved matrix in order to paste it to a sample(s), 
click Compensation o Copy Saved. A window will open allowing the user 
to locate the saved TXT file. The saved compensation matrix can then be 
pasted to selected samples in the File Inspector. 
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• Save New – if you wish to save an altered compensation matrix as a TXT 
file, highlight the sample in the File Inspector and click Compensation o 
Save New. A window will ask to select a destination and create a name for 
the saved file. 

• Save FCS Original – if you wish to save an original compensation matrix 
(that created at the time of acquisition) as a TXT file, highlight the sample in 
the File Inspector and click Compensation o Save FCS Original. A window 
will ask to select a destination and create a name for the saved file. 

• Paste – once a compensation matrix (an original matrix, a new matrix or one 
copied from a TXT file) has been copied to the clipboard it can be pasted to 
FCS files highlighted in the File Inspector. Copy the desired matrix, highlight 
the FCS files in the File Inspector and click Compensation o Paste. A 
window will open displaying the matrix to be displayed. Click Yes to paste 
the matrix. 

 
 

 
 
 
Document – the document menu provides functions available when in 
DocLogic. 
• Document – select Document and either Add Document, to create a new 

document, or highlight an existing document in the File Navigator window 
and select Remove Document to delete it. A prompt window will ask to 
confirm this action before deleting. 

• Page Setup – click Page Setup followed by either Screen or Paper. 
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• Print – selecting Print will print the current report document. A prompt 
window will ask to set the printer and paper settings. 

• Add – use the add option to insert various elements into the report 
document. 

 

 
 

These include: 
• Plots 
• Tables (Stat Table or Metadata) 
• Shape (Rectangle, Rounded Rectangle or Circle) 
• Line 
• Text 
• AutoText - options are as follows: 

 

 
 

• Image – a window will open asking to locate the image file. 
• Present – select Present to display the report as a presentation. Choose 

a monitor to display the presentations on (if more than one is connected). 
• Show/Hide Preview – the Page Preview is the outline of the pages in the 

current document displayed down the right-hand side of the Report 
Workspace. This can be shown or hidden by selecting Document o 
Show/Hide Preview 

• Export – selecting Document o Export will allow the document to be 
saved as one of the following file types: 

 



 30 

 
 
License 
 

 

 

• Activate License… – to activate a license, enter the username associated 
with a valid license code. 

• Release License… – release a license if you wish to run FlowLogic on 
another computer. Activate the license on the second computer when you 
launch FlowLogic. 

• Remote Activation – remote activation can be used when there is no internet 
connection. When selecting this option, a window with included instructions 
will open enabling the generation and saving of a fingerprint. This can then 
be saved and transferred to a different computer with internet access. The 
fingerprint can be authenticated resulting in the generation of a license key. 
This key can be transferred back to the computer running FlowLogic in order 
to activate the license. 

• Remote Release – remote release is also used when there is no internet 
connection. The process is the same as that for remote activation. After the 
fingerprint is generated, FlowLogic will close and will require an available 
username (or fingerprint if offline) in order to run. 
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Help 
 
• Search – use the ‘Search’ feature under the Help menu to search for help 

and guidance. 
 

 
 
• Tutorials – this option links to the FlowLogic support page on the Inivai 

website, where PDF guides and demonstration videos can be accessed. 
• Memory Settings – clicking Help o Memory Settings will prompt FlowLogic 

to test the current memory settings. A window will open displaying the result 
and asking if you would like to change the memory settings. If you choose 
Yes, the program Preferences will open. From here, navigate to the System 
settings to change the memory settings. 

 
 

 
 
 
Saving and Opening Analysis Files 
File Menu 
• Once you have imported FCS files and performed an analysis you will be 

able to save the analysis as either a GLF or an Experiment. Both options 
can be found in the File menu. 

 
GateLogic File (.GLF) 
• This file type will save your analysis along with all the gates and statistics. 

The GLF will save the pathway for each of the imported FCS files. If the 
location of these files changes then FlowLogic will ask you to manually 
locate the file or select a folder to search in. 

• To open a GLF file, start FlowLogic, choose ‘Open GLF’ from the File menu 
and locate the saved GFL file. 

• To save a GLF, after importing FCS files, choose ‘Save GLF’ (or ‘Save As 
GLF’ to rename the new GLF file) from the File menu. 
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GateLogic Experiment (.GatelogicExperiment file) 
• Saving your analysis as an Experiment will compress your analysis and 

FCS files together into one file. This single file can be transferred to any 
computer running FlowLogic. 

• To open an experiment file, start FlowLogic, choose ‘Open Experiment’ from 
the File menu and locate the saved experiment file. When the Experiment 
is opened, it will create a folder containing the FCS files. 

 
 
Exporting FCS files from a saved GateLogic Experiment 
FCS files can be exported from a GateLogic Experiment (.GatelogicExperiment 
file) by re-saving the analysis as a .GLF. As a .GLF contains the XML and not 
the FCS files, a prompt will ask if you would like to save the FCS files in the 
same location as the new .GLF. When creating the new .GLF, the FCS files 
contained in the experiment will be extracted and placed in a new folder. 

 

 
 


